Just bring along your digital camera card and

we’ll develop, on Birtley Front Street, your prints

to professional lab quality for as little as 10p.

Or take advantage of our packages:

50 6x4 Prints for just £5.00

or
50 7x5 Prints for just £7.00

Or for that ideal gift idea bring along your
favourite picture and let us do the rest!!

OR we can save
all images to CD

!
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Presidents Piece

The winter is now nearly behind
us and we are all looking forward to
a spring and a summer of even more
photography.

Your executive however have been
looking foward to our next convention
which is our 75th so we have been
putting together a special programme to
mark the event.

The weekend will continue at
Hillscourt until the Sunday lunchtime with
a Sunday morning lecture rather than a
visit fo a local attraction.

Our main event on the Saturday is an international family duo from
Holland. Gijs van Gent is an international photo journalist with a very high
reputation on the continent, and the supporting “act” will be his wife who is an
excellent AV worker in the traditional style. They are over in the UK for an RPS
tour and we have been able to book them, as they do not have any bookings
over our weekend.

On Sunday morning we will hear Marjorie Salisbury with a new print,
and those who have seen Marjorie before will know that it will be of excellent

quality.

The Council have considered all of the comments, both good and bad,
from the last convention. One of the major problems last year was the sound
system that is installed in the hall. The system is set up for operation from the
dais and there are dead spots in the hall when it is used from the floor of the
room. We are therefore arranging for a fixed mike to be available so that we
can eliminate that problem.

The other difficulty that was overcome for the lecture was the digital
projector fixed to the ceiling of the hall. This is set up for graphics as the Union
are obviously using it for PowerPoint presentations and the like and not for
photographic presentations. Again we are going to hire in a digital projector,

4

that is calibrated for photographic presentations.

A good weekend with the normal excellent friendship thrown in is
guaranteed.

Put the date in your diary

Friday 15th September to Sunday 17th.

We are also having two special issues of the Litle Man although the first
will cover reports on the Convention and the Gold Label results as usual and
that in itself fills the magazine and the following spring issue will include some
extra material, and we hope that we will get some interesting and amusing
historical reminiscing from the circles. It is up to all members to try to make the
editions as interesting as possible and the editor will welcome your memories
and articles.

Looking back at the old editions it brings back memories about the long
discussions that we had in the executive meetings and at the circle secretaries
meetings about whether to accept digital or not. No we find that more
photographers are using digital both for taking and more so with printing.

Looking at the most recent edition of Jessops catalogue they has 56
pages of digital cameras and only 5 pages for traditional film cameras. Nikon
have announced that they are stopping production of all of their film cameras
other than two professional models. Minolta and Konica have sold out. The
photographic world is changing fast and most audiovisuals are being produced
in digital form rather than with slides. Famous names are disappearing with
Minolta and Konica selling out to Sony. Minolta at one time was the largest
producer of SLR cameras in the world. Nikon also have announced that they
are stopping film camera production other than for their professional camera,
as 96% of their sales was from digital cameras.

| am pleased to say that UPP have embraced digital and most circles are
now accepting both forms of printing. At the end of the day it does not matter
how it is printed, as what we are looking at is the final image and how pleasing
is the final picture. New members coming into UPP are mostly print workers
which shows the strength of digital, slide circles are just holding their
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own, although in most circles many slides are also being made from
digital files. UPP must not stand still and we must continue to embrace all forms
of our wonderful hobby.

It was suggested in the last Little Man that we formed a digital AV

circle and | was surprised that so far | only have had two members wishing to
participate. | was very surprised at that.

Brian

Articles for Sale

Minolta 800si film camera with Minolta VC-700 GRIP with 24 -85

Minolta zoom lens, an electronic long cable release.
Large camera bag to fit a SLR and a couple of lens +15 rolls of film
filters batteries efc.

A UNILOCK SYSTEM 700 tripod Very good condition, no
scratches. This tripod is not a light weight tripod has no case but very
versatile.(similar to the original benbo tripod)

OFFERS

ROD DIXON 01992301851 OR
rodney.dixon2@ntlworld.com

Our Thanks to the Avertisers, without
whom we would not have a Magazine

Judges or Aunt Sallies ?

Judges are always fair game and their season is ever an open one.
Drop into any camera club and one will hear criticisms of judges being
flaunted around all over the place. They are fair game but no doubt the
judges themselves fully appreciate this aspect of their voluntary activities
knowing full well that at some time or another they would have been expressing
similar adverse comments of their own. How many times have |, on my
homeward journey from a distant club, agonised over whether my choices had
been the correct ones and should | after all have awarded top place to that
very nice nude rather than the landscape | Once only in a long judging career
did | ever have anyone walk out on me — it was the Chairman’s wife who
considered my 6/10 less than satisfactory. She did return later however and
argued her point |

| am certain it is no different in UPP except that in circles we are all
judges whether we know it or not. Federations expect new judges to their
lists to reach a certain standard but here in UPP the most inexperienced new
member comments and casts votes like a good old veteran whether or not they
fully understand the difficulties that had gone into producing an entry. Perhaps
it is no bad thing after all because that way the old clichés and prejudices
do not enter the fray and maybe we get a much more honest opinion being
expressed. Who knows 2

| was once one of the selectors for the RPS annual International Print
Exhibition and was astonished at the end to discover that no, or very few,
landscape prints had been selected by my fellow judges despite the fact that |
had seen some very worthwhile ones passing through our hands. | decided to
have my say and much to the anger of the helpers packing up the rejects half a
dozen landscapes came back into the reckoning from which we finally selected
three. Weeks later | felt my stubbornness had been vindicated when in writing
up the exhibition a much respected photographer selected two of the initially
“rejected” landscapes to illustrate his article in a prestigious camera magazine.
So there is hope for us all after all perhaps and it is worth while sticking to
one’s opinions despite what everyone else in the box has written.

Most of us | am sure have heard of, if not watched, the two television
programmes “Strictly Ballroom” and its ice skating equivalent when thousands
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of viewers enjoyed the various spectacles. But what amazed me was
the receptions given to the invited expert judges when at times shouts of abuse
and much booing was evident when “wrong” decisions were perceived by the
audience to have been meted out to their celebrity favourites.

What fun it would be if vociferous catcalls and worse greeted decisions
made by camera club judges which were not in line with prevalent opinion.
And where would that all lead to 2 | cannot wait for the day!

Onlooker

Canon, Nlikon & Fuji Pro Specialists

OPEN 7 DAYS!

www-mlfsuds-com

Best UK Deals!! Online Shop!! Updated Daily!!

Specialising in Pro  Semi

Pro and ENnthusiast Film &
Digital Equipment

P/ X Welcome ~ Collection
Service Available

Tel: (O1803)
S52400

27 Bolton St, Brixham, S.Devon, TAS 983Z

Email: info@mifsuds.com
Fax: (0O1803) 855907

UPP Website is WWW.uppofgb.org

\

Hadrian’s Wall-Leighton Herdson Print and Roland
Jonas Trophy and Plaque 2005

Photography has been a hobby for over half a century with monochrome
prints of landscapes my primary interest. | rarely carry a camera preferring
to make a mental note of potential locations to return to when conditions are
favourable.

| had seen this view during my many walks along sections of Hadrian's
Wall and envisaged a dramatic landscape with the feeling of desolation and
wilderness that for me go hand in hand with the location and history of this
place.

It is about an hour’s drive from where | live so it was fairly easy to get
there when weather conditions were favourable. The viewpoint is about half
a mile west from Steel Rigg car park. It was taken with a Canon F1n and a
Canon FD 28mm lens on Kodak Ektachrome slide film and was hand held.

At the time | was more than pleased with the result but didn’t think
it quite had the drama | envisaged; colour had glamorised the scene.
The Digital Lightroom enabled me to scan the slide and convert it into a
monochrome file using Photoshop’s Channel Mixer. It was then printed with an
Epson 1290 Inkjet Printer using the black ink only onto Fuji Multijet Premium
Gloss paper.



Having only joined the UPP and Circle 18 less than a year ago you can
imagine my surprise fo win both the Leighton Herdson Print Trophy and the
Roland Jonas Landscape Trophy with my very first print.

Eric Athroll

This article should have appeared in the last issue.
The editor apologises for the omission.

Editor’s Notes
With regret | have to note that there has been no rush of applicants
for my job as editor. It appears that the privileges aftached to the job such
as joining the great British media community, a seat at the Council table
and free travel to and fro from the Great Wen are not sufficient inducement.
Nevertheless, the clock is ticking.

The contributers to the magazine are fewer than should be, but are
consequently the more appreciated. They have been exceptionally good in
providing their copy early.

Walter Steiner

Circle 24

We continue to accept both slides and prints in the Circle. We have
two members sending in slides showing some unusual and interesting
work.

The membership has crept upwards over the year. Most are sending
in A4 prints which are digitally produced.

Creative pictures are still in evidence especially from the members
who have been in the Circle for several years.

Folios are still going out every three months.

Jim Marsden
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CIRCLE ELEVEN'’S FIRST EXHIBITION

Thirteen of the members of Circle Eleven are to stage their first group
exhibition. A variety of photographic styles using conventional and digital
processes provide a wealth of creative images from members around England
from North to South and including West Wales. A number of the members
regularly have work exhibited in international exhibitions and have become
well known for the quality of their photography around the world. Most Circle
Eleven members also hold photographic distinctions awarded by bodies such
as The Royal Photographic Society among others.

The Photographers decribe themselves as follows—
Paul Damen BA, ARPS

A professional photographer based in North Norfolk, Paul’s

commercial work usually employs digital capture and output.

I\ He still maintains a darkroom and enjoys the hands-on nature

| of the traditional chemical processes.  Paul’s personal pho-

tography is mainly based on landscape and he tries to create

images that offer a number of potential layers of interpretation.
Web: www.pauldamen.co.uk

Sara J.Bunn ARPS

_ | have always been passionate about taking pictures, and com-

&85 bined with my other passions of horses and painting. | have a

“ fascinating mixture fo experiment with.

&, | first studied formally with a City and Guilds photographic

§ course, at that time | had a conventional darkroom, and

L/ gained my Licentiateship panel using film and my darkroom.

"\ When Digital Imaging came along | joined the Royal Photo-

J graphic Societies Digital Imaging Group and embraced the

“= new technology enthusiastically. | belong to a photographic
group called Infinity Plus and we have held exhibitions of our

pictures around the counties of Hereford, Worcester, and Gloucester. | also

belong to a postal portfolio group C11, and was a member of Worcester

Camera Club.

| also enjoyed watercolour painting very much, so with the use of digital imag
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ing | now have the best of all worlds in that | can present my photographic
work with a watercolour overtonel | was lucky enough to gain my Associate-
ship with the Royal Photographic Society with a panel of equine pictures that |
endeavoured to look like watercolour images.

Mick Willis

Mick has been a member of Circle 11 for some 20 years. The contrasting
styles of the various circle members over the years have made
C11 generally somewhat different to local Photographic Socie-
ties. He works entirely in monochrome and changed from
conventional silver printing to digital about five years ago.

His interest in photography started in his early teens being

| taught to print by his father who had been a keen photogra-
pher all his life and particularly in the twenties. His enthusiasm
rubbed off on both Mick and his brother Tony.

Mick is a member of the Ware and District Photographic Soci-
ety and is still surprised by the keen interest in monochrome photography, per-
haps even an upturn in the number of black and white entries in the monthly
competitions brought on no doubt by the number of people working digitally.

Liz Scott ARPS

Born and educated in Eastbourne, Liz has always been pas-
sionate about black and white photography and especially the
darkroom.

. She is an Associate of the Royal Photographic Society, a
member of Eastbourne and Hailsham Photographic Societies
as well as UPP C11. Liz regularly exhibits her work nation-
ally and internationally and in 2000 was invited to become a
Member of The London Salon of Photography.

Inspiration for her work is taken from the local landscape, familiar objects and
nature. She has a special interest in environmental portraiture, fashion and the
relationship between people and their surroundings.

Although embracing this digital age her love for traditional, silver based pho-
tography is still strong and much prefers to spend her time in the darkroom.
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Brian Whiston

| have enjoyed taking and looking at pictures most of my life. |
joined a local club in the early sixties, but due to the inexperi-
ence of the members this club didn't last very long. Some of
us then joined Tonbridge Camera Club where | have been a
_ member for 35 years. | was a committee member for most

B of this time and was also Club Chairman. | Joined UPP over
¥ 25 years ago and | am still a member. | was also a member of
Sevenoaks Camera Club for 20 years or more.
| enjoy most forms of photography, but particularly enjoy ‘photo-reportage’
and portraiture.

Jim Dolan

Many of us have lost touch with the food chain that supports
our day-to-day life. There has been an ever-lengthening se-
quence of ideas that joins us to those who produce our food.
While we may see the occasional bakery and field of corn and
be able to envisage the activities and processes, generally we
have become ever more distant from those for meat.
Considerable skills are required to choose between one beast
and another and to enable us to enjoy the best flavours and nutrition with a
minimum of waste.

The traditional butcher buys “sides” and “carcases” and skilfully reduces them
to something that fits info a kitchen and will become delicious on a plate.

(A completely separate skill set and value set runs the animal husbandry and
slaughter side of our food chain: | leave it fo others to expose the worst and
celebrate the best of those.)

My picture series offers a glimpse into the working life of a traditional butcher
shop. This one is in Harrogate, but definitely not in the tourist town centre.

Bob Norris AFIAP APAGB

Born in 1939 at Ponders End North London and moved to
Herttordshire in the early fifties and now lives in the village of
Standon in East Hertfordshire.
& o Bob's first introduction to photography was at the age
: % of 11years when the school he was attending decided to give
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the pupils an optional afternoon of study on various subjects. Bob's first choice
was music where he was taught to play the violin - this didn’t last long, he then
joined the photography group. This was the beginning of a life long associa-
tion with photography. On leaving full time education at the age of fifteen Bob
became a junior technician with Hertfordshire County Council’s Photographic
Unit. After a gap of ten years Bob continued in part time education and gradu-
ated from the Polytechnic of Central London (Now the University of Westmin-
ster) as a mature student in 1980. Bob was employed as a photographer for
forty-five years and retired as Hertfordshire’s Chief Photographer in December
1999.

Although Bob takes mainly landscapes he enjoys any form of photog-
raphy. Bob first joined UPP Circle 11 in the early seventies but due to pres-
sure of work resigned after about six years, then rejoined after he had refired
- a gap of about twenty years. Now only uses the digital process to produce
his images, has had over one hundred acceptances in National and Interna-
tional Photographic Salons in the past four years, and has received numerous
awards.

Chrissie Gamble LRPS

| have been interested in photography as a medium for many
years. A photographic image can expose so many emotions
and almost always transcends nations.

Images are a capable and powerful way of exposing situa-
tions of conflict and misery throughout the world and afford a
compelling means of bringing about change.

However it is only in the last few years | have enjoyed the privilege of immers-
ing myself in this art form that affords me my personal opportunity for self-ex-
pression. | find it difficult to describe that ‘great inside thing” | get from creating
an image that reflects how | felt at the decisive moment | chose to capture.
However, if | had to find words for me ‘Harmony” and ‘Delight’ would spring
to mind. Harmony, for at that moment of pressing the shutter | am completely
and utterly captivated and absorbed in my subject, whatever form that might
have taken. Delight! So many things delight me but encapsulating a precious
moment in time in a tangible way remains in my un-technological mind such
an astonishing thing to be able to do. | hope those feelings remain with me
always.
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Clive R. Haynes FRPS

Clive has been active in photography for over 40 years and

in that time has explored monochrome and colour darkroom
skills, “alternative processes’, hand tinting, multi-projector A-V's
and most recently, a range of digital techniques.

4 Clive’s work has appeared in galleries and exhibitions, he has
authored books and his photographs have been used in numerous publica-
tions.

Having taught City and Guild’s Photography and Digital Imaging at college for
many years he continues to run occasional courses on Photography and digital
skills with Photoshop.

In addition, Clive belongs to four fine-art photography discussion groups and
runs his own web pages to help photographers gain a betfter understanding

of a wide range of techniques. He is a committee member of the RPS DIGIT
Group, Organiser for the RPS Digital Imaging Group in the Midlands, an ac-
tive lecturer on the ‘club circuit’ and a passionate believer that ‘photography
should communicate’.

Web: www.crhfoto.co.uk

Colin Southgate ARPS, DPAGB

| have been involved in photography for about twenty years
now. Monochrome is still as important to me as colour despite
the advance of digital imaging. | like using infra-red film and |
have a fondness for unusual and slightly bizarre pictures. | also
have a great love for archaic styles of photography typified by
‘the photo-secessionists of the late nineteenth century.

Being a member of circle eleven is very important o me. It allows me

to gain in-depth opinions on my photographs. In return | can
enjoy seeing many very fine pictures from other members and
| express honest opinions upon a marvellous variety of images.

Arnold Hubbard FRPS, EFIAP.

N
I, )
W N /\

o Over 55 years of photography seems a long time but | still
. enjoy it greatly. It was always the darkroom, with monochrome
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a first love, but the last two or three years I've been confined to the computer
with more bias towards colour work, enjoying landscape, people pictures, still
life and travel photography.

Though | have supported my local club for 35 years, being a member of vari-
ous groups outside the club scene has always been very important, to maintain
a wider view of photography and meet with like minded people.

Lecturing, judging, international exhibiting and some teaching have all been a
rewarding part of photography during the past 30 years, hopefully it will go on
for a few more years.

Pat Jones FRPS EFIAP MPAGB APAGB

It is no exaggeration to say | have a passion for prints and
where possible try to capture the ever-changing light and
moods of the natural world, always searching for detail, pat-
terns and textures that make up our landscapes.

| lecture extensively up and down the country and currently am
President of the Kent County Photographic Association.

Peter Yeo FRPS, APAGB

Peter Yeo was introduced to photography whilst training as a
Royal Air Force Apprentice at RAF Hereford in the mid-1950s’.
At first his intention was to record the many interesting places
that a Service career was to take him during 33 years in
uniform. Gradually he turned to more creative and pictorial
representation of the places he visited throughout Europe, the Middle and Far
East.

From the start, Peter served on photographic society committees and has held
every post one can imagine. He has been President of the Lincolnshire Photo-
graphic Association, the body looking after the interests of Clubs and Societies
in the county, and is President of R.B.Camera Club, formerly Ruston-Bucyrus
Camera Club, which now meets in Nettleham Village Hall, some four miles
north of Lincoln, on Friday evenings throughout the year. Peter was, until
recently, Vice-President of the North & East Midlands Photographic Federation,
covering the counties of Lincolnshire, Nottinghamshire and Derbyshire.
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Peter’s main interests lie in travel and landscape photography and it is these
areas that he gained the Fellowship of the Royal Photographic Society and the
Distinction of the Photographic Alliance of Great Britain. Peter is a sponsored
speaker, supported by Fotospeed Digital Imaging, and has, for more than 35
years, taken his photography to Clubs from North London to north of Inver-
ness, and from Norfolk to North Wales. He exhibits in local, regional, national
and international exhibitions and is in demand as a selector at federation,
national and international level.”

The Exhibition will be staged at:

St.Margaret’s Church, Thorpe Market in North Norfolk, from SUNDAY 30th
JULY to SATURDAY 12th AUGUST 2006

It will be open daily 11am to 5pm and entry is Free.

Car parking is available and there is disabled access to the church. Light
refreshments will be served for the duration of the exhibition.

Besides its regular religious services, a number of art, craft and musical events
are held at St.Margaret’s throughout the year and it has become a very popu-
lar venue in recent years. Its award-winning churchyard contains a wide vari-
ety of wild flower species and the church itself is of unique symmetrical design
faced with local knapped flint. More information about the church and its
activities at www.thorpemarket.org.uk

Some of the exhibits in the Circle Eleven Exhibition will be available for pur-
chase with a percentage of the price being donated to St.Margaret’s Church
funds. All income from refreshments will also go to the church.

St.Margaret’s Church, Thorpe Market can be found close to the A149 twixt
North Walsham. and Cromer in North Norfolk.

Further details and images available from
Paul & Christine Damen

2 Hall Cottages

Bacton Road, Paston

Norfolk NR28 9TZ

Tel: 01263 720973

Email: uppcl 1@imageast.org.uk

Watching by Crissie Gamble
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Anyone At Home
r".’ Norman Moor

€3

Ice Bergs Adrian
Davies C3

Jerome Alan Brown C4

chher by Jim Dolan

el

Blue Dome by Arnold Hubbard Beach; St lves by Liz Scoff

Green Hairstreak
Nigel Turnbull
C NHCC1

Washday Blues Norman Robson
ARPS DPAGB BPE2* C4

Dune by Pat Jones
The White House Colin

Douglas ARPS CPAGB
BPE3*' €7

Speed Angle
Paul Hoffman

&7

Woodland mist by Colin Southgate
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Lion

. Hodge Close

All pictures by
1 Martin Addison

Lakeside Reeds

Staring Fox by Sara Bunn

Dune Shadow by Paul Damen
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Lilac Breastsed Roller
and
Burchell’s Zebra Trio
by Angela Rixon ARPS
C20

Towards Hoscostones

Jack Bamford DPAGB C20

N VRN
White Faced Darter and Black Tailed Skimmer by John Berry ARPS C26

Baltimore Bea-

con Jack Hack-
ett LRPS C26

Throttle Hand
Peter Crook ARPS C20
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WS TR /-t

Man from Senegal Bernard

C Baker AFIAP APAGB C23/34

Dinosaur Hunter

Monty Trent C29

The Prismatic Springs
Elizabeth Hilton LRPS
C29

Lily Time Sheila Read
_ FRPS C DI 5

Skiddaw from
Bassenthwaite
Lake Frank Stir-
rup C32

The Juniper Tree

Frank Stirrop C32 Red Stag Neil Humphries C32

Callanish
Frank Stirrup C32
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Kentwell
Suffolk Ken Payne
C9 '

Assignation Peter

Tulloch ARPS C33

Sprinters Colin Douglas ARPS
CPAGB BPE3* C35

Lily Blooms Drying
Ray Hadlow
ARPS FRPS C10

Water Splash

Colin Douglas
ARPS CPAGB BPE3* C7

Thai Boatman

Simon Edwards C35

Ullswater lan Jolly

CPAGB LRPS C35

Backstage
Deryck Cutler ARPS
AFIAP BPE4* C20

Winter Light lan Jolly CPAGB
LRPS C35

Soft Au’run Colc.)urs
Martin Addison FRPS C36

Wood Carving Peter
Moody ARPS DPAGB
C8

Ngorongoro Dust

Dawn Angela
Rixon ARPS C20

Winter on Twistleton Dave Coates
ARPS EFIAP MPAGB C36 Bird In Window David Eaves

ARPS C36
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Painter IX for Photographers

I have been using Corel Painter to make pictures for many years and find it a
fascinating and rewarding program. | am often asked why | use this program
when Photoshop is so versatile, and the answer is that the approach to making
a picture is totally different and | end up with pictures which | would not have
otherwise made. Painter and Photoshop are perfect partners to work together;
each has strengths in different areas.

Painter was originally created for artists who wanted to replicate the results of
using traditional art materials but needed to do so in a digital way. This has
been and remains the primary function of the program in the same way that
Photoshop is aimed at photographers; but as Photoshop has become a tool
which painters can use, so Painter has expanded its techniques to encompass
photographs.

Painter was taken into the Corel family of products about two years ago and
has received a lot of investment to improve the usability; a simple cloned pic-
ture can now be produced quickly from a good original photograph.

Let’s look at how the program works. We start by importing a photograph into
Painter, this can be in Photoshop, TIFF or JPEG format, Painter is very compat-
ible with Photoshop and will happily handle PSD files with layers intact. When
the picture has opened in Painter the first step is to make a clone copy, this
produces a new document which is electronically linked to the original photo-
graph and as we start to clone, the picture is reproduced in the new document
and is modified by the choice of brushes and paper textures chosen.

So before we start to clone, we have to choose a suitable brush. The range of
brushes is vast, over 600 different brushes to choose from and that is before
we start to customise them. The brushes are grouped in brush categories so
that for example all the Watercolour brushes are together. There are brush
categories for all the types of brush which a painter might use in traditional art,
pastels, chalk, pencils, acrylics, oil, conte, the list goes on and on.

When we have selected the brush type we can then choose a suitable paper,
again there is a huge variety of paper surfaces available, everything from
canvas, watercolour paper, wood and many unusual surfaces. The reason for
choosing a paper is that many brush types will interact with the paper, so a
piece of chalk pulled across a rough surface will have a very broken up ap-
pearance in the final picture, just as in a pastel painting.

Some brush categories like watercolour are quite amazing in the way they rep-
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licate traditional painting, for instance when painting ‘wet-on-wet” traditionally,
wet paint is floated on a wet canvas and the paint runs down the paper, how
far depends on the angle the canvas s tilted. Painter replicates this by allowing
you to specify that the paper should be wet and also to decide at what angle
the paper should be. You can also tell the paper to dry and continue painting
on top with a wet on dry technique.

In the oil and acrylic categories where paint can be applied very thickly in an
Impasto manner, the brush strokes are made to look three dimensional by the
addition of shadows to the finished painting.

Having had a very quick look at a few of the special techniques available in
Painter, what sort of pictures can we produce from photographs? Just about
anything really. It is really easy to make very soft delicate interpretations which
still look much like photographs, right through to very painterly versions which
have the appearance of a real painting, especially when printed on textured art
paper.

If you would like to make painterly interpretations of your photographs | can
thoroughly recommend this brilliant program.

My book ‘Painter IX for Photographers’ is available from all good bookshops
and also on-line from Amazon. The retail price is £27.99.

There is a web site to accompany the book which is at www.painterforphotog-
raphers.co.uk where examples of pictures and tutorials can be found.

Creating a picture using paper textures

(refer to page 21 for illustrations)

This step-by-step example will add paper textures as part of the picture
and will give the impression of a painting made on a coarse textured paper.

The original photograph of St Conan’s Kirk in Scotland had some simple
repair work done in Photoshop prior to opening in Painter. The contrast was
increased slightly and the blue sky was extended down to cover some eye-
catching white clouds. It was not necessary to do this very precisely, as the
cloning process will cover up any minor imperfections.

Step 1 File> Open> St Conans Kirk'’
Step 2 File> Quick Clone.
Step 3  Select the Brush icon in the Toolbox.
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Step 4 From the Brush Selector bar choose the Chalk category and select
Square Chalk 35 as the Brush Variant. Although we are cloning, the Chalk
brush is not in the Cloners brush category and therefore you must change

it from the default setting, which is painting colour, to cloning mode so that
the brush picks up detail from the original image. This applies to all brush
categories except Cloning. If the General palette is not on screen go to
Window>Brush Controls> Show General. All the Brush Control palettes will
appear on screen so click on the General palette heading and drag it out from
the rest, you can then remove the other palettes which will not be needed by
clicking on the 'x’ top right of the palette stack.

Step 5 There are two controls to be adjusted to change this brush to work as
a cloner. In the Method box change the setting to Cloning, this will make the
brush use the original picture as the source for colour. Then in the Subcategory
box select Grainy Hard Cover Cloning, this will tell the brush to use the paper
texture when painting.

Step 6 Change the brush size to 35.0 and the Opacity to 5%. If you are
using a mouse rather than a pressure sensitive pen | suggest you use 1% or 2%
opacity, this will enable you to build up the textures more slowly.

Step 7 You now need to choose a paper texture and if the papers palette

is not on the screen go to Window> Library Palettes> Show Papers. Open

the Papers palette and click on the small paper icon on the right side of the
palette. This will reveal a drop down menu showing the Painter IX default set of
papers, select the ltalian Watercolor Paper.

Step 8 Paint the main lines of the building with the tracing paper turned on.
Tracing paper is a feature which overlays the picture you are cloning into with
a light image of the clone source (the original photograph) to help the early
brush strokes. These initial marks should be very light and you will need to turn
the tracing paper on and off many times to see what you have painted. Once
you have all the main building areas indicated on the picture you can turn off
the tracing paper.

Step 9 Gradually build up the picture working from the building outwards
keeping the textures light, your brush strokes should be following the direction
of the building, never simply stroke the brush across the picture, always think
about which way the brush strokes will look best. Once the whole picture has
been lightly covered start to go over the buildings again, use the same opacity
and this will slowly make the details more distinct. You can slightly increase the
opacity if necessary but it is generally better to allow the brush strokes to build
the picture, that way you have more control.

Step 10 Use the magnifier slider below the image to work at a bigger
magnification, and then reduce the brush size to about 10.0 and paint over the
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building outlines making them more prominent. Increase the opacity to 10%
and emphasize the shadow areas in the buildings.

Step 11 Experiment with different brush sizes and opacities to see how they
affect the picture, try brush size 72 with 5% opacity and sweep over the main
areas, this will bring more detail in and smooth out some of the irregularities
caused by the brush strokes. One of the most difficult decisions is to know
when to stop as it is easy to overwork a picture and bring back too much of the
original image.

Martin Addison FRPS

Circle 35.

Despite the relentless march of digital photography and the move away
from film Circle 35, being a slide circle, continues to maintain a strong
core of members. This is mainly because members can have digital files
converted to slides by Micro-quiz; I wonder though how long MQ will
be able to obtain the slide film stock to continue this invaluable service!
We had a new member join recently, Diane Foord, the wife of Ken Foord,
who is one of our established members. Diane will provide some female
support for our only other lady member, Sandy Hawkyard.

David Bennett, secretary C35.

Loch Leven and Taking a Leek
both by lan Bailey ARPS C8
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What is a Circle Secretary??

A circle SEC is an ordinary human being like the rest of us, but he must
acquire virtues beyond belief.

He must have the patience of Job, the fortitude of a martyred saint, the
wisdom of Solomon, the communications expertise of IBM and the tact of a
diplomat.

At times he must be both Father Confessor and a combination of the
Governor and Chief Warder of Dartmoor.  He requires the output of Saudi
Arabia to pour on troubled raters and a supply of birch in order to wield the
heavy stick.

He must be able to do without sleep and work at his best until the early
hours of the morning turning a late folio round, in order that it starts out on
time. He needs a computer for a memory to be able to locate any one of five
boxes anywhere between eighteen members throughout the country, and the
ability of a cypher expert to decode the voting cards.

A knowledge of Corporate Planning is essential to be able to maintain
a flow of boxes with up to 25 sets of holiday dates notified in arrears and the
ability to re-plan the entire rota for all boxes at any given moment in order to
cope with last minute changes. He also has the qualities of a rubber ball to
come bouncing back after each set-back.

He types at 120 words a minute or writes even faster his home looks like
the Secretary’s office at ICl, but without the staff, and his wife often wonders
if that is her husband who continually sits at his desk with his back to her and
grunts when a fresh cup of coffee is placed before him.

The Circle sec has the knowledge of all photographic encyclopedias
rolled into one and must be able to give an answer to any problem raised in
the notebook without hesitation. In order to complete the notebook he must
be able to converse with knowledge on any subiject in the world and sometimes
even further afield!

He must be all things to all members, he has the vision of a clairvoyant,
the skill of a professional administrator, the hide of a rhinoceros, the neck of a
giraffe and the craft of a confidence trickster.

Above all else he must be human: strangely enough, we find one for
each circle!

Brian Hirschfield
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HISTORY suoesuows

JUDGES AWARDS

Design, coding, text & graphics ROY MOORE DPAGB
Voiceover IAN WIGSTON Music DAVE LAWS
Picture scans KEN PAYNE
© UPP COPYRIGHT 2000 - 2005

U.P.P.

Note: The CD will play on all PCs and Macs G4 &
G5 using operating systems 9 & 10

The Application Form is on the
next page
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GOLD SHOWCASE CD ORDER FORM

Prices include Post and Packing

Please tick box

2000 Gold Showcase CD. PC & Mac £7
2001 Gold Showcase CD PC & Mac £8
2002 Gold Showcase CD PC & Mac £9

2003 Gold Showcase CD PC only, with Flash Technology £10
2004 Gold Showcase CD PC only, with Flash Technology £11

2005 Gold Showcase CD With Flash Technology. £11

Note The 2005 CD will play on all PCs and G4 &G5
Macs using operating systems 9 & 10

Please make cheques payable to “UPP of Great Britain” and send to:
Ken Payne, 38 Lodge Crescent, Walthem Cross, Hertfordshire EN8 8BS

Enquiries to Ken Payne at 01992 30 91 76
or kenneth.paynel@ntlworld.com
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ESSOPS

10TH YEAR 3RD YEAR

NO.1 IN PHOTOGRAPHY RUNNING RUNNING
WINNER | ( WINNER

J

e Leading photo,
camcorder and digital
brands stocked

e Equipment repairs

e Digital demonstration
facilities

e Developing and
printing

e Photographic courses

e Credit options

(see in-store for details)

([ JESSOPs | W——-
WE CHECK
PRICES SO
YOU DON'T

HAVE TO

We check our competi
y
always get a great deal

:., That's the Jessops
difference

@0 Over 280 stores nationwide
“!!.' call 0845 458 7111 for your nearest store

= www.'esso $.COM order securely on-line
ways ‘ i
Jessops Direct
buy

Jessops, Jessop House, Scudamore Road, Leicester, LE3 1TZ

freephone 0800 083 3113 (i o esom

Sun 10.00am-5.00pm
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DI 1 Rally 2005

Once again the Windermere hotel was the venue for DI 1, DI4, and
friends. The Autumn leaves were wonderful, but the weather was not. Such
small problems, however, never dampen the enthusiasm of our members,
and everybody had a wonderful rally. There were several sunny intervals, with
magic light, so nobody
.| would go home without
one or two masterpieces
—-maybe. At least one
— member concentrated

s on wet cobbles and
umbrellas, for which the
conditions were ideall

The Windermere
hotel was again totally
helpful, the food was
excellent and the
entertainment superb,
provided by all the
members who took their pictures along. There was an amazing variety of
styles and subjects and time passed all too quickly. The patches of unhelpful
weather gave members extra time to explore the lesser known coffee shops
of Cumbria, but the extra calories would be burnt off in the search for images
when the rain stopped,-hopefully.

Any of the group not able to be there really missed out. For sheer
enjoyment the DI get together is amazing, and a lot of thanks are due to Liz
Boud the organiser, who has triumphed again!

A memorable moment, - on being told that one person did not want ‘a
full English breakfast’ said with horror, ‘You want a Scottish breakfast?’

Anne Swearman ARPS EFIAP DPAGB APAGB

The Convention celebrating the 75th birthday of UPP will
be on 15th to 17th September. Special events are planned
including a free drink and a group photograph. Can you
afford to miss it ?
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Obituary - Tadeus Palmer ABIPP
A member of Circle 14 since 1968 Tad sadly died October 2005.

He was a popular Club judge in the London area and it was on one such
visit to my club in Barnet during 1973 that he encouraged me to join UPP
and C14. Tad was a man of presence and warmth and became a truly good
friend. He was highly experienced in all aspects of photography having held
senior positions with such companies as Johnsons of Hendon, Agfa-Gevaert,
Paterson Products and formerly with ICl and the Chemical industry.

Tadeus Podhorodenskiwas born in the Polish town of Srem where his father
was Chief Executive of Local Government. Their home was on the banks of the
River Warta, where Tad formed his love of sailing. With the onset of war, Tad
aged 15, was obliged to flee with his mother across Poland by car, horse, cart,
bicycle, train and foot enduring several encounters with the Gestapo. Eventu-
ally he arrived in ltaly, from there went to France and eventually embarked,

in company with hundreds of refugees, on a requisitioned Polish Liner for an
unknown destination which turned out to be Plymouth, England.

Moved as refugee across the country Tad resumed his schooling in Peebles
and in Rothesay when his linguistic ability enabled him quickly to become fluent
in English. Schooling completed, he studied ship building and chemistry and
the latter formed the foundation for his future career.

In 1945 Tad enlisted with the Polish Army in Scotland, was commissioned and
sent to Germany and elsewhere in Europe as liaison officer at displaced per-
sons camps. Moving back to the UK Tad found that his Officer status opened
many doors in post war London. His ballroom dancing skills were fully exploit-
ed leading to him meeting Celia whom he married in 1947, Tad achieved full
British Nationality and, after several moves bought a house at Palmers Green,
North London. The name ‘Palmer’ from this location prompted Tad to adopt
this as a simpler surname.

Tad made a successful application to the British Institute of Professional Photog-
raphers for Associateship and following his period with Paterson Products acted
as Consultant to the Daily Express to train their darkroom technicians.

Celia and Tad were a devoted couple. She was a successful business-
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woman in her own right. They relocated to Scotland and then to Essex where
they pursued their love of sailing and increased their already wide circle of
friends.

Celia was struck down with Motor Neurone Disease and died during 2004,
Tad was broken hearted and started to suffer ill health shortly after her death.
Tad will be sadly missed by all who had the pleasure of knowing him, and his
photography and notebook entries will leave a gap in Circle 14 after so many
years.

Roy E.A.Jones ARPS (Circle 14)

A Pair of old Boilers Colin Lusby
C10

In Yer Face Steve Peet
DPAGB C 10

36

United Photographic Postfolios of Great
Britain
Membership Application Form

Full Name\Distinctions
Address

Telephone
Email Address

To ensure that you join a circle that will correctly cater for your personal
interests, please tick the appropriate box.

A3 A4 A5
Monochrome ] ] ]
Colour only ]

Mixed C_] ] 1]
Digital ]

Slides 2"X2" General [__] Natural History [_]
Non Voting Prints [__] Slides ]
Please enclose a cheque made payable to U.PP

Between 1st September-30th April £13.50
Between 1st March and 31st August £ 675

For each Additional Circle £ 3.00

Post this form or a copy of it with cheque to membership secretary Mrs Liz Boud,
Holly Cottage, Laundry Lane, Chelwood Gate, Haywards Heath, East Sussex,
RH17 7LB on 01825 74 06 98 email lizboud@isleofthorns.wanadoo.co.uk

Treasurer Informed ]

Membership No |:|
Circle Allocated [___]

Secretary informed [ |
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8¢

Details of the Circles

Circle Size Type mounted Notes
accepted
2/:25 A4 mixed yes
3 8x10 mixed no On A4 paper
4 A4 to A3 mixed either
6 8x10 mixed no prints produced in Darkroom
negatives by any means
7 A5 mixed no Mainly B+W but accept colour
8 12x16 b-w only yes
9 7x5 mixed yes
10 12x16 b-w only yes
11 8x10 mixed yes
12 12x16 darkroom + DI,B-W  light mount Occasional colour allowed
14 A3 mixed yes
17 7x5 darkroom + DI,B-W yes
18 12x16 darkroom + DI,B-W  yes
192 12x16,0r A3 mixed colour only yes
20 12x16 mixed yes
23-34 35mm slides incl. DI
24 slide-printA4  mixed no  Source can be Dl or film. Creative, 4 Folios/year
26 12x16 or A3 mixed colour only yes

6¢

Circle Size
accepted

28 35 mm slides
29 12 sq ins

30 12 sq ins

31 35 mm slides
32 35 mm slides
33 35 mm slides
35 35 mm slides
36 35 mm slides

NHccl 35mm slides
NHcc?2 35mm slides

AA 12x16 or A3
DI, 1 A4
DI,2 A4
DI,3 A4
DI, 4 A4
DI,5 A4

Details of the Circles

Type

mixed
mixed

ncludes DI

Natural History
Natural History

mixed

DI

Dl

Dl

DI

Dl

mounted Notes
yes 7'%h"
yes colour or monochrome

darkroom or digital

no
no
no
no
no
no Creative work only




C2/25

C3

C4

Cé

c7

C8

C9

C10

ci

C12

C14

C17

C18

C19

C20

Circle Secretaries

A.F.Elliott 14 Ewden Road, Wombwell,Barnsley, S. Yorks, $73 0RG
R.Bennett 43 Riverside Road, Newark,Notts, NG24 4RJ
ARPS email ralpheyesight@talktalk.net
Mrs V.Burdis West View, Darlington Road, Northallerton, North Yorkshire

DL6 2NN  email val@vburdis.fsnet.CO.uk
C.Snelson ‘Joan Lear’, Middlesmoor, Harrowgate, N. Yorkshire

HG3 58T email colinorann@aol.com
C.A.Douglas 144 Nutgrove Road, St Helens, Merseyside WA9 5JP
ARPS CPAGB PBE 2* email yoko597@aol.com
D.S.Maslen 107 Oxstalls Way, Longlevens, Gloucester,Gloucestershire
DPAGB BPE 2* GL29JU  email donmaslen@talk21.com
D.Apple 38 Harrow Road, West Bridgford, Nottingham, Notts
NG2 7DU email dennis.apple@ntiworld.com

N.N.Bodle 4 Corsica Villas, Brenchley Road, Matfield, Tonbridge, Kent

TN127PS  email bodle@4corsica.freeserve.co.uk
R.Poynter 232, Limes Avenue, Chigwell, Essex, IG7 5L.Z

email richard.poynter@uvirgin.net

Dr A.Robson 66 Leeds Road, Selby, North Yorkshire, YO8 4JQ
FRPS email arobson233@aol.com
P.A.Blow 39 Cogdeane Road, West Canford Heath, Poole, Dorset

BH179AS  email pabloid@bournemouth-net.co.uk
H.C.Thompson 2 Ellesmere Rise, Great Grimsby, N.E Lincolnshire

DN34 5SPE  email harold@haroldthompson.wanadoo.Co.uk
A.J.Potter 4 Gilgarran Park, Gilgarran, Workington, Cumbria, CA14 4RA
ARPS DPAGB email tonypotter@hotmail.com
P.M.Antrobus 2, Grain Mill House, ‘The Maltings’, Lillington Avenue

FRPS Leamington Spa, Warwickshire, CV32 5FF

A.J.Potter 4,Gilgarran Park, Gilgarran, Workington, Cumbria, CA14 4RA

C23/C34  Mrs H.Sayer

C24

6 Albert Road, Lenzie, Kirkintilloch, Glasgow, G66 5AS
email helen_sayer@yahoo.co.uk

J.Marsden FRPS 22 Godwin’s Close, Atworth nr Melksham, Wilts, SN12 8LD

EFIAP, APAGB

email jimmarsden@atworth43.freeserve.co.uk
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01226 2118 29

01636 6512 77

01609 77 49 64

01423 75 56 91

01514 26 57 87

0145252 4171

01159 14 58 38

01892723910

020 8501 14 97

01757 70 22 28

0120260 3279

014723133 49

01946 83 01 30

01926 33 42 28

01946 83 01 30

01417 76 16 89

012257917 28

C26

Cc28

Cc29

C30

c3

C32

C33

C35

C36

AJA

NHCC1

NHCC2

DI

DI2

DI3

DI 4

DI5

P.M.Antrobus
FRPS

J.W.Bullen
Colin Westgate
FRPS MFIAP

Hon PAGB

Garry Bisshopp
LRPS

1. Whiston

B.C.Hall

Mrs P.Sherren
ARPS
D.Bennett
L.W.Platt MFIAP
FRPS HonEFIAP
HonPAGB

P.A.Blow

P.T.Chadd

Mrs K.Bull ARPS
EFIAP MPAGB

Mrs L.Boud

B. Davis
K.Payne
Mrs A.J.Stobbs

CPAGB

B.Davis

Circle Secretaries

2, Grain Mill House, ‘The Maltings’, Lillington Avenue,
Leamington Spa, Warwickshire, CV32 5FF

13 Luard Court, Warblington, Havant, Hants, PO9 2TN
email johnbullen@iclway.co.uk

Stable House, 2, Carriers Close, Coast Road, West Mersea

Colchester , Essex CO58NY email questphoto@btinternet.com

6 Belgrave Crescent, Seaford, East Sussex,BN25 3AX
email garrybisshopp@onetel.com

Rose Bank, 52 Green Avenue, Davenham, Northwich, Cheshire
CW98HZ email ianwhiston@hotmail.com

49 Calder Avenue, Brookmans Park, Hatfield, Herts, AL9 7AH
email brianchall@btinternet.com

9 Vale Close, Galmpton, Brixham, Devon, TQS 0LX
email pamsherren@hotmail.com

55, Highthorpe Crescent, Cleethorpes, N.E.Lincolnshire
DN359PX email bof55@tiscali.co.uk

Yewtree Cottage, Derrit Lane,Bransgore, Hants BH23 8AT
email ianwplatt@talk21.com

39 Cogdeane Road, West Canford Heath, Poole, Dorset
BH179AS  email pabloid@bournemouth-net.co.uk

6, Nicholass Court, Dale Road, Purley, Surrey, CR8 2ED

‘Segsbury’, St John’s Road, Crowborough, E.Sussex, TN6 1RT
email kath.bull@virgin.net

Holly Cottage, Laundry Lane, Chelwood Gate, Haywards Heath
East Sussex RH17 7LB
email lizboud@isleofthorns.wanadoo.co.uk

1 New Road, Wingerworth, Chesterfield, Derbyshire,
S426TB  email brian@thedavis.co.uk

38, Lodge Crescent, Waltham Cross, Hertfordshire
EN8 8BS email kenneth.payne1@ntiworld.com

36 Findhorn Place, Troon, Ayrshire, KA10 7DJ,
email snapdragon@omne.uk.net

1 New Road, Wingerworth, Chesterfield, Derbyshire,
S426TB email brian@thedavis.co.uk

4]

01926 33 42 28

02392 47 69 78

01206 38 45 84

0132389 11 46

01606 43 79 4

01707 65 58 66

01803 84 34 01

01472 20 04 63

017255116 85

0120260 3279

02087 6397 73

01892 66 37 51

0182574 06 98

01246 27 54 33

01992309176

01292317225

01246 27 54 33



President

Vice President

Immediate Past
President

Hon. Life Member

General Secretary

Treasurer

Membership & Folio
Secretay

Publicity Secretary

Editor, ‘Little Man’
Competition Secretary
Prints

Competition Secretary
Slides

Circle Secretaries
Representative

Stationery Officer
FRICS

Ordinary Members
Representative

.Archivist

Council Members 2005 2006

B.Davis

L.Boud

K.Payne
J.W.Bullen
S.Berg

ARPS APAGB

W.B.Evans
FRPS APAGB

F.AH. Ouvry
LRPS

L.Boud

A. Swearman
APRS DPAGB
APAGB

W.Steiner
DH1 3DY

K.Payne
A.T.E. Homes
APAGB

P.A Blow
B.Davis

R.Bennett

H.Fisher
LRPS CPAGB

1, New Road, Wingerworth Chesterfield, Derbyshire
S426TB  email brian@thedavis.co.uk

Holly Cottage,Laundry Lane,Chelwood Gate,
Haywards Heath East Sussex RH17 7LB
email lizboud@isleofthorns.wanadoo.co.uk

38, Lodge Crescent, Waltham Cross, Hertfordshire
EN88BS  email kenneth.paynei@ntiworld.com

13 Luard Court, Havant, Warblington,
Hants, PO9 2TN email johnbullen@iclway.co.uk

68, Mowbray Road, Edgware
Middlesex, HA8 8JH

18, Buttermere Close, Cockermouth,
Cumbria, CA139JJ email barryevans@onetel.com

17 Tebourba Drive, Alverstoke,Gosport, Hants, PO12 2NT
email francisdebbie@ouvry.wanadoo.co.uk

Holly Cottage,Laundry Lane,Chelwood Gate,

Haywards Heath East Sussex RH17 7LB

email lizhoud@isleofthorns.wanadoo.co.uk

30, St Lucia Close, Whitley Bay, Tyne & Wear

NE26 3HT email anne.swearman@blueyonder.co.uk

Longlands, 5 Quarry Heads Lane, Durham DH1 3DY
email upp@walter2007.plus.com

38 Lodge Crescent, Waltham Cross

01246 27 54 33

0182574 06 98

01992309176

02392476978

020 89 58 95 55

01900 8224 79

023 92 58 06 36

01825 74 06 98

01912533130

0191 38 64 66 2

01992309176

Hertfordshire, EN8 8BS email kenneth.payne1@ntiworld.com

22, Wycherley Crescent, Barnet
Hertfordshire, ENS 1AR email alan.homes@nasuwt.net

39 Cogdeane Road, West Canford Heath, Poole, Dorset
BH17 9AS email pabloid@bournemouth-net.co.uk

1 New Road, Wingerworth,Chesterfield
Derbyshire, S42 6TB email brian@thedavis.co.uk

43 Riverside Road, Newark, Notts, NG24 4RJ
email ralpheyesight@talktalk.net

21, Brockwood Crescent,Keyworth Notts, NG12 SHQ
email howard.fisher@ntiworld.com
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020 84 40 34 33

01202603279

01246 27 54 33

01636 651277

01159 37 28 98

Colorado Dunes lan Platt MFIAP
FRPS C36

New Forest Autumn Leo Rich ARPS
EFIAP DPAGB APAGB C36

r Impressions Do—r:.Longford LRPS
APAGB DPAGB C DI 2

Lunch Rained off Geraint James
ARPS AWPF C Di 2

43



